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 ؟Excel( في EDAما اليجف الخئيدي مؼ التحميل الاستكذافي لمبيانات ) -1
 الأنساط والقيّػ الستطخفة البيانات بذكل أعسق واكتذاف فيػ -ب Trendlineالتحميل التشبؤي باستخجام  تشفيح -أ

 إنذاء رسؽم بيانية معقجة -د تشعيػ البيانات في ججاول محؽرية -ج
 تُدتخجم لاستخخاج جدء مؼ الشص بجءًا مؼ مؽقع محجد؟ Excelأي دالة في  -2
 FIND)( -د RIGHT)( -ج LEFT)( -ب MID)( -أ

 التالية تُدتخجم لتحميل البيانات الزخسة بذكل متقجم؟أي مؼ الأدوات  -3
 Excelدوال الشرؽص في  -د SPSS و Hadoop -ج الججاول السحؽرية -ب MS Excel -أ

 أي دالة تدتخجم لحداب متؽسط القيػ التي تدتؽفي شخطًا محجدًا؟ -4
 AVERAGEIF)( -د SUMIF)( -ج COUNTIF)( -ب AVERAGE)( -أ

 ؟A1:A10كيف يسكؼ الحرؽل عمى القيسة الععسى في نطاق بيانات  -5
 =AVERAGE(A1:A10) -د =  SUM(A1:A10) -ج =  MIN(A1:A10) -ب =MAX(A1:A10) -أ

 ما نؽع التحميل الحي يخكد عمى دراسة البيانات التاريخية لتقجيخ الاتجاىات السدتقبمية؟ -6
 تحميل الشرؽص -د التحميل الؽصفي -ج التشبؤي التحميل  -ب التحميل الاستكذافي -أ

 أي مؼ ىحه الجوال تدتخجم لمبحث عؼ مؽقع حخف أو نص داخل خمية؟ -7
 FIND)( -د MID)( -ج LEN)( -ب SUBSTITUTE)( -أ

 أي مؼ ىحه الجوال يُدتخجم لجسع القيػ التي تدتؽفي شخطًا محجدًا؟ -8
 SUM)( -د SUMIF)( -ج AVERAGEIF)( -ب COUNTIF)( -أ

 تؽفخ تحميلات إحرائية معقجة؟ Excelأي مؼ ىحه الأدوات يُعج إضافة متقجمة في  -9
 Data Validation -د Format Painter -ج Spell Check -ب Analysis ToolPak -أ

 ؟SUBSTITUTEأي مؼ ىحه الخيارات يسثل استخجامًا صحيحًا لمجالة )( -10
 =SUBSTITUTE(A1, "old", "new") -ب =SUBSTITUTE(A1, "new", "old") -أ

 =SUBSTITUTE("old", A1, "new") -د =SUBSTITUTE("new", "old", A1) -ج
 ؟LENما الغخض مؼ استخجام الجالة )( -11

 استبجال جدء مؼ الشص -أ
  -ب

 تحؽيل الشص إلى أحخف صغيخة -ب
 معيؼحداب عجد الأحخف في نص  -د البحث عؼ كمسة محجدة -ج
  

 :الآتٌة الخٌارات من الصحٌحة الإجابة اختر  السؤال الأول 
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 كيف يسكؼ حداب ندبة الخطأ بيؼ القيسة الستؽقعة والفعمية؟ -12  
 =SUM)القيسة الستؽقعة, القيسة الفعمية(  -أ

 القيسة الفعمية= -القيسة الستؽقعة  -ب
 =   ABS (100*(/ القيسة الفعمية( القيسة الستؽقعة -)القيسة الفعمية ) -ج
 القيسة الستؽقعة=القيسة الفعمية /  -د

 (؟Pivot Tablesما الؽظيفة الأساسية لمججاول السحؽرية ) -13
 إنذاء رسؽم بيانية ديشاميكية -ب تمخيص البيانات وعخضيا مؼ زوايا متعجدة -أ

 تحميل الشرؽص وتشعيفيا -د إجخاء عسميات حدابية معقجة  -ج
 تُدتخجم لمتشبؤ بالقيػ السدتقبمية بشاءً عمى بيانات تاريخية؟ Excelأي مؼ الأدوات التالية في  -14

 FORECAST.LINEAR -ب Conditional Formatting -أ
 Text to Columns -د Data Validation -ج

 ؟Excelما الخطؽة الأولى لإنذاء ججول محؽري في  -15
 اختيار نؽع الخسػ البياني -ب تطبيق التشديق الذخطي -أ

 تحجيج خمية داخل نطاق البيانات السخاد تحميميا -د إدخال البيانات يجويًا -ج
 ؟COUNTIFأي مؼ ىحه الخيارات يسثل استخجامًا صحيحًا لمجالة )( -16

 =COUNTIF("East", B2:B20) -ب =  COUNTIF(A1:A10, ">50") -أ
 =COUNTIF(B2:B20, AVERAGE) -د =  COUNTIF(A1:A10, SUM) -ج

 الفخق الخئيدي بيؼ التحميل الخطي وغيخ الخطي في التشبؤ؟ ما -17
 غيخ الخطي أسخع مؼ الخطي -أ

 الخطي يدتخجم لمبيانات الشرية وغيخ الخطي لمخقسية -ب
 الخطي يفتخض علاقة مدتقيسة بيؼ الستغيخات, وغيخ الخطي لمسشحشيات -ج
 الخطي يحتاج إلى بيانات أقل -د

 ؟Excel( إلى رسػ بياني في Trendlineاتجاه )كيف يسكؼ إضافة خط  -18
 Insert > Chartمؼ قائسة  -أ

 Add Trendlineبالشقخ بدر الساوس الأيسؼ عمى نقطة بيانات واختيار  -ب
 Data > Filterمؼ قائسة  -ج
 TRENDباستخجام دالة )( -د
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 ؟VLOOKUPما فائجة الجالة )( -19 
 جسع القيػ بشاءً عمى شخط -ب استخخاج نرؽص مؼ الخلايا -أ

 حداب عجد الخلايا التي تحتؽي عمى قيػ رقسية -د البحث عؼ قيسة في ججول باستخجام معيار محجد -ج
 في تحميل الشرؽص؟ TRIMما الغخض مؼ الجالة )( -20

 تحؽيل الشص إلى أحخف كبيخة -ب حداب عجد الأحخف في الشص -أ
 إزالة السدافات الدائجة بيؼ الكمسات -د استبجال نص معيؼ بشص آخخ -ج

 

 

 تشبؤي  وصفي أنؽاع التحميل
   حداب متؽسط السبيعات الذيخية

   لمتشبؤ بالسبيعات السدتقبمية FORECAST.LINEARاستخجام 
   بالطقذتحميل الأنساط التاريخية لمتشبؤ 

   إنذاء ججول محؽري لتمخيص البيانات
 

 

 .Excelدتخجم لتحجيج القيسة الرغخى في مجسؽعة بيانات في تُ  __________الجالة  -1
  , وتحميل الشرؽص.__________: التحميل الاستكذافي, التحميل Excelمؼ أنؽاع التحميل التي يسكؼ تشفيحىا في  -2
  .عمى نقطة البيانات __________( في الخسػ البياني, نشقخ بدر الفارة Trendlineلإضافة خط الاتجاه ) -3
 .تُدتخجم لحداب عجد الخلايا التي تحتؽي عمى قيػ رقسية في نطاق محجد __________الجالة  -4
 .وتشؽعيا __________ لتحديؼ دقة الشسؽذج التشبؤي, يجب الاىتسام بكسية البيانات و -5

 

 

 العامؽد الثاني  العامؽد الأول
 SUMIF 1)(  ... استخخاج جدء مؼ الشص مؼ اليدار

 FIND 2)(  ... بشاءً عمى شخط حداب مجسؽع القيػ
 AVERAGE 3)(  ... البحث عؼ مؽقع حخف معيؼ في الشص

 LEFT 4)(  ... حداب متؽسط القيػ
 

 :صنفّ أنواع التحلٌل التالٌة إلى وصفً أو تنبؤي  السؤال الثانً 

 :الأول العمود مع المناسب رقمال الثانً العمود من اختر  الرابعالسؤال  

 أكمل الفراغ بالكلمات المناسبة فٌما ٌأتً:  السؤال الثالث 
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  أداة مشاسبة فقط لمبيانات الرغيخة ولا يسكؼ استخجامو لمبيانات الزخسة. Excelيُعجُّ بخنامج  (...) -1
 .( لاكتذاف الأنساط والقيػ الستطخفةEDAيُدتخجم التحميل الاستكذافي لمبيانات ) (...) -2
 .تُدتخجم لاستخخاج جدء مؼ الشص مؼ الخمية VLOOKUPدالة  (...) -3
 .Excelلمتشبؤ غيخ الخطي في  Trendlineيسكؼ استخجام  (...) -4
 .تُدتخجم لتحؽيل الشص إلى أحخف كبيخة TRIMدالة  (...) -5

 

 

 

 ؟Excelما ىي أنؽاع تحميل البيانات التي يسكؼ تشفيحىا باستخجام  -1
 ............................................................................................................الإجابة: 

 

 عج عسمية تشعيف البيانات خطؽة ميسة في تحميل البيانات؟لساذا تُ  -2
  ............................................................................................................ الإجابة:
         ............................................................................................................ 

 

 ما العؽامل التي تؤثخ في دقة الشسؽذج التشبؤي؟ -3
 ............................................................................................................الإجابة: 

 

 :ل غيخ الخطي في التشبؤ بالبياناتقارن بيؼ التحميل الخطي والتحمي -4
  ............................................................................................................ الإجابة:

         ............................................................................................................  
         ............................................................................................................ 

 

 :التحميل التشبؤي , التحميل الؽصفي, تحميل البيانات عخف السرطمحات الآتية: -5
  ............................................................................................................ الإجابة:

         ............................................................................................................               
         ............................................................................................................ 
         ............................................................................................................ 

 

 

 ( أمام العبارة الخاطئة:( أمام العبارة الصحٌحة وإشارة )ضع إشارة )  السؤال الخامس 

 أجب عن الأسئلة المقالٌة التالٌة:  السادسالسؤال  
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  AVERAGEبالشعخ إلى بيانات السبيعات الذيخية التالية, استخجم دالة )( -1
 لحداب متؽسط السبيعات:     

 .…………………………….…………………………الإجابة: 
 
 
 

 إلكتخونيات"لسشتجات مؼ فئة "باستخجام الججول أدناه, احدب مجسؽع أسعار ا -2
 :SUMIF)( الجالة باستخجام     

 .…………………………….………………………… الإجابة:
 
 
 
 

 FORECAST.LINEARبالشعخ إلى بيانات استيلاك الكيخباء الذيخية )بالكيمؽواط(, استخجم  -3
 :6إلى  1لمتشبؤ بالاستيلاك في شيخ تسؽز إذا كانت الأشيخ مخقسة مؼ      

 .…………………………….…………………………الإجابة: 
 
 , فسا نتيجةA1إذا كان لجيغ الشص "أحسج محمد سالػ" في الخمية  -4

 ؟ LEN(A1)الريغة =     
 .…………………………….…………………………الإجابة: 

 
 
 مؼ الججول التالي: 204لمبحث عؼ السعجل الشيائي لمطالب الحي رقسو  VLOOKUPاستخجم  -5

  .…………………………….………………………… الإجابة:
  

 التالٌة: ٌةالحسابأجب عن الأسئلة   السابعالسؤال  

 السبيعات الذيخ
 6000 كانؽن الثاني

 8000 شباط
 7000 آذار

 

 الدعخ الفئة السشتج
 500 إلكتخونيات ىاتف

 1500 إلكتخونيات حاسؽب
 300 أثاث كخسي

 

 الاستيلاك الذيخ
1 450 
2 470 
3 500 
4 520 
5 550 
6 600 

 

 السعجل اسػ الطالب رقػ الطالب
 85 عمي 201
 86 ليمى 204
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 ؟Excel( في EDAما اليجف الخئيدي مؼ التحميل الاستكذافي لمبيانات ) -1
 الأنساط والقيّػ الستطخفة البيانات بذكل أعسق واكتذاف فيػ -ب Trendlineالتحميل التشبؤي باستخجام  تشفيح -أ

 إنذاء رسؽم بيانية معقجة -د تشعيػ البيانات في ججاول محؽرية -ج
 تُدتخجم لاستخخاج جدء مؼ الشص بجءًا مؼ مؽقع محجد؟ Excelأي دالة في  -2
 FIND)( -د RIGHT)( -ج LEFT)( -ب MID)( -أ

 بذكل متقجم؟أي مؼ الأدوات التالية تُدتخجم لتحميل البيانات الزخسة  -3
 Excelدوال الشرؽص في  -د SPSS و Hadoop -ج الججاول السحؽرية -ب MS Excel -أ

 أي دالة تدتخجم لحداب متؽسط القيػ التي تدتؽفي شخطًا محجدًا؟ -4
 AVERAGEIF)( -د SUMIF)( -ج COUNTIF)( -ب AVERAGE)( -أ

 ؟A1:A10كيف يسكؼ الحرؽل عمى القيسة الععسى في نطاق بيانات  -5
 =AVERAGE(A1:A10) -د =  SUM(A1:A10) -ج =  MIN(A1:A10) -ب =MAX(A1:A10) -أ

 ما نؽع التحميل الحي يخكد عمى دراسة البيانات التاريخية لتقجيخ الاتجاىات السدتقبمية؟ -6
 تحميل الشرؽص -د التحميل الؽصفي -ج التحميل التشبؤي  -ب التحميل الاستكذافي -أ

 ىحه الجوال تدتخجم لمبحث عؼ مؽقع حخف أو نص داخل خمية؟أي مؼ  -7
 FIND)( -د MID)( -ج LEN)( -ب SUBSTITUTE)( -أ

 أي مؼ ىحه الجوال يُدتخجم لجسع القيػ التي تدتؽفي شخطًا محجدًا؟ -8
 SUM)( -د SUMIF)( -ج AVERAGEIF)( -ب COUNTIF)( -أ

 تؽفخ تحميلات إحرائية معقجة؟ Excelأي مؼ ىحه الأدوات يُعج إضافة متقجمة في  -9
 Data Validation -د Format Painter -ج Spell Check -ب Analysis ToolPak -أ

 ؟SUBSTITUTEأي مؼ ىحه الخيارات يسثل استخجامًا صحيحًا لمجالة )( -10
 =SUBSTITUTE(A1, "old", "new") -ب =SUBSTITUTE(A1, "new", "old") -أ

 =SUBSTITUTE("old", A1, "new") -د =SUBSTITUTE("new", "old", A1) -ج
 ؟LENما الغخض مؼ استخجام الجالة )( -11

 استبجال جدء مؼ الشص -أ
  -ب

 تحؽيل الشص إلى أحخف صغيخة -ب
 حداب عجد الأحخف في نص معيؼ -د البحث عؼ كمسة محجدة -ج
  

 :الآتٌة الخٌارات من الصحٌحة الإجابة اختر  السؤال الأول 
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 بيؼ القيسة الستؽقعة والفعمية؟كيف يسكؼ حداب ندبة الخطأ  -12  
 =SUM)القيسة الستؽقعة, القيسة الفعمية(  -أ

 القيسة الفعمية= -القيسة الستؽقعة  -ب
 =   ABS (100*(/ القيسة الفعمية( القيسة الستؽقعة -)القيسة الفعمية ) -ج
 القيسة الفعمية / القيسة الستؽقعة= -د

 (؟Pivot Tablesالسحؽرية )ما الؽظيفة الأساسية لمججاول  -13
 إنذاء رسؽم بيانية ديشاميكية -ب تمخيص البيانات وعخضيا مؼ زوايا متعجدة -أ

 تحميل الشرؽص وتشعيفيا -د إجخاء عسميات حدابية معقجة  -ج
 تُدتخجم لمتشبؤ بالقيػ السدتقبمية بشاءً عمى بيانات تاريخية؟ Excelأي مؼ الأدوات التالية في  -14

 FORECAST.LINEAR -ب Conditional Formatting -أ
 Text to Columns -د Data Validation -ج

 ؟Excelما الخطؽة الأولى لإنذاء ججول محؽري في  -15
 اختيار نؽع الخسػ البياني -ب تطبيق التشديق الذخطي -أ

 تحميمياتحجيج خمية داخل نطاق البيانات السخاد  -د إدخال البيانات يجويًا -ج
 ؟COUNTIFأي مؼ ىحه الخيارات يسثل استخجامًا صحيحًا لمجالة )( -16

 =COUNTIF("East", B2:B20) -ب =  COUNTIF(A1:A10, ">50") -أ
 =COUNTIF(B2:B20, AVERAGE) -د =  COUNTIF(A1:A10, SUM) -ج

 ما الفخق الخئيدي بيؼ التحميل الخطي وغيخ الخطي في التشبؤ؟ -17
 الخطي أسخع مؼ الخطي غيخ -أ

 الخطي يدتخجم لمبيانات الشرية وغيخ الخطي لمخقسية -ب
 الخطي يفتخض علاقة مدتقيسة بيؼ الستغيخات, وغيخ الخطي لمسشحشيات -ج
 الخطي يحتاج إلى بيانات أقل -د

 ؟Excel( إلى رسػ بياني في Trendlineكيف يسكؼ إضافة خط اتجاه ) -18
 Insert > Chartمؼ قائسة  -أ

 Add Trendlineبالشقخ بدر الساوس الأيسؼ عمى نقطة بيانات واختيار  -ب
 Data > Filterمؼ قائسة  -ج
 TRENDباستخجام دالة )( -د
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 ؟VLOOKUPما فائجة الجالة )( -19 
 جسع القيػ بشاءً عمى شخط -ب استخخاج نرؽص مؼ الخلايا -أ

 حداب عجد الخلايا التي تحتؽي عمى قيػ رقسية -د معيار محجدالبحث عؼ قيسة في ججول باستخجام  -ج
 في تحميل الشرؽص؟ TRIMما الغخض مؼ الجالة )( -20

 تحؽيل الشص إلى أحخف كبيخة -ب حداب عجد الأحخف في الشص -أ
 إزالة السدافات الدائجة بيؼ الكمسات -د استبجال نص معيؼ بشص آخخ -ج

 

 

 تشبؤي  وصفي أنؽاع التحميل
   حداب متؽسط السبيعات الذيخية

   لمتشبؤ بالسبيعات السدتقبمية FORECAST.LINEARاستخجام 
   تحميل الأنساط التاريخية لمتشبؤ بالطقذ
   إنذاء ججول محؽري لتمخيص البيانات

 

 

 .Excelدتخجم لتحجيج القيسة الرغخى في مجسؽعة بيانات في تُ  MIN)(الجالة  -1
  , وتحميل الشرؽص.الدمشي: التحميل الاستكذافي, التحميل Excelمؼ أنؽاع التحميل التي يسكؼ تشفيحىا في  -2
  .عمى نقطة البيانات الأيسؼ( في الخسػ البياني, نشقخ بدر الفارة Trendlineلإضافة خط الاتجاه ) -3
 .تُدتخجم لحداب عجد الخلايا التي تحتؽي عمى قيػ رقسية في نطاق محجد COUNT)(الجالة  -4
 .وتشؽعيا جؽدتيالتحديؼ دقة الشسؽذج التشبؤي, يجب الاىتسام بكسية البيانات و  -5

 

 

 العامؽد الثاني  العامؽد الأول
 SUMIF 1)(  4 استخخاج جدء مؼ الشص مؼ اليدار
 FIND 2)(  1 حداب مجسؽع القيػ بشاءً عمى شخط

 AVERAGE 3)(  2 البحث عؼ مؽقع حخف معيؼ في الشص
 LEFT 4)(  3 حداب متؽسط القيػ

 

 :صنفّ أنواع التحلٌل التالٌة إلى وصفً أو تنبؤي  السؤال الثانً 

 :الأول العمود مع المناسب رقمال الثانً العمود من اختر  الرابعالسؤال  

 أكمل الفراغ بالكلمات المناسبة فٌما ٌأتً:  الثالثالسؤال  
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 الفصل الدراسً    
2022/2023 

 الدرس الأول

 

 الوحدة الأولى

 

 الصف

 

 المادة

 

 الفصل الدراسً
 الأول

 2025/2026 

 الدرس الرابع
 تحلٌل البٌانات

 

 الوحدة الأولى
 تحلٌل البٌانات

 

 الصف
 العاشر

 

 المادة
المهارات 

 الرقمٌة

 

 منهاج

 أردنً

 

 

 

 

 

1- ()  يُعجُّ بخنامجExcel .أداة مشاسبة فقط لمبيانات الرغيخة ولا يسكؼ استخجامو لمبيانات الزخسة  
2- () ( يُدتخجم التحميل الاستكذافي لمبياناتEDAلاكتذاف ) الأنساط والقيػ الستطخفة. 
3- ()  دالةVLOOKUP تُدتخجم لاستخخاج جدء مؼ الشص مؼ الخمية. 
4- ()  يسكؼ استخجامTrendline  لمتشبؤ غيخ الخطي فيExcel. 
5- ()  دالةTRIM تُدتخجم لتحؽيل الشص إلى أحخف كبيخة. 

 

 

 

 ؟Excelما ىي أنؽاع تحميل البيانات التي يسكؼ تشفيحىا باستخجام  -1
 .التحميل التشبؤي , و التحميل الؽصفي, تحميل الشرؽص, تحميل الدمدمة الدمشية, التحميل الاستكذافي لمبياناتالإجابة: 

 

 عج عسمية تشعيف البيانات خطؽة ميسة في تحميل البيانات؟لساذا تُ  -2
 لأن تشعيف البيانات يزسؼ دقة وسلامة عسمية التحميل مؼ خلال معالجة القيػ السفقؽدة أو التكخارات, مسا يجعل  الإجابة:
 الشتائج أكثخ مؽثؽقية.         

 

 ما العؽامل التي تؤثخ في دقة الشسؽذج التشبؤي؟ -3
 .ع البيانات وميداتياتشؽّ , و جؽدة البيانات, كسية البياناتالإجابة: 

 

 :ل غيخ الخطي في التشبؤ بالبياناتبيؼ التحميل الخطي والتحمي قارن  -4
 بيشسا  FORECAST.LINEARيفتخض التحميل الخطي وجؽد علاقة خطية بيؼ الستغيخات, ويدتخجم لجوال مثل  الإجابة:

  Trendlineالتحميل غيخ الخطي يدتخجم عشجما تتبع البيانات مشحشيات مثل المؽغاريتسية أو الأسية, ويعتسج عمى          
 بأنؽاعيا.         

 

 :التحميل التشبؤي , التحميل الؽصفي, تحميل البيانات عخف السرطمحات الآتية: -5
 تحميل البيانات: عسمية متكاممة تيجف إلى استخخاج القيسة مؼ البيانات مؼ خلال فحريا وتجييدىا وتشعيفيا  -الإجابة: 

 وتحؽيميا إلى صيغ ملائسة.            
 التحميل الؽصفي: أداة أساسية لتمخيص البيانات وعخضيا بطخيقة مبدطة لفيػ الأنساط والعلاقات. -         
 تشبؤي: دراسة البيانات التاريخية لتقجيخ الاتجاىات أو الشتائج السدتقبمية.التحميل ال -         

 

 

 ( أمام العبارة الخاطئة:( أمام العبارة الصحٌحة وإشارة )ضع إشارة )  السؤال الخامس 

 أجب عن الأسئلة المقالٌة التالٌة:  السادسالسؤال  
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 الفصل الدراسً    
2022/2023 

 الدرس الأول

 

 الوحدة الأولى

 

 الصف

 

 المادة

 

 الفصل الدراسً
 الأول

 2025/2026 

 الدرس الرابع
 تحلٌل البٌانات

 

 الوحدة الأولى
 تحلٌل البٌانات

 

 الصف
 العاشر

 

 المادة
المهارات 

 الرقمٌة

 

 منهاج

 أردنً

 

 

 

 

 

 

  AVERAGEدالة )(بالشعخ إلى بيانات السبيعات الذيخية التالية, استخجم  -1
 لحداب متؽسط السبيعات:     

 = = 7000AVERAGE(6000, 8000, 7000)الإجابة: 
 
 
 

 إلكتخونيات"لسشتجات مؼ فئة "باستخجام الججول أدناه, احدب مجسؽع أسعار ا -2
 :SUMIF)( الجالة باستخجام     

 =SUMIF(B2:B4, ","إلكتخونيات C2:C4) = 2000 الإجابة:
 
 
 
 

 FORECAST.LINEARبالشعخ إلى بيانات استيلاك الكيخباء الذيخية )بالكيمؽواط(, استخجم  -3
 :6إلى  1لمتشبؤ بالاستيلاك في شيخ تسؽز إذا كانت الأشيخ مخقسة مؼ      

 =FORECAST.LINEAR(7, B2:B7, A2:A7) = 630الإجابة: 
 
 , فسا نتيجةA1إذا كان لجيغ الشص "أحسج محمد سالػ" في الخمية  -4

 ؟ LEN(A1)الريغة =     
 .)بسا في ذلغ السدافات( 15عجد الأحخف = الإجابة: 

 
 
 مؼ الججول التالي: 204لمبحث عؼ السعجل الشيائي لمطالب الحي رقسو  VLOOKUPاستخجم  -5

 =VLOOKUP(204, A2:C3, 3, FALSE) = 88الإجابة: 
 
 

     

 أجب عن الأسئلة الحسابٌة التالٌة:  السابعالسؤال  

 السبيعات الذيخ
 6000 كانؽن الثاني

 8000 شباط
 7000 آذار

 

 الدعخ الفئة السشتج
 500 إلكتخونيات ىاتف

 1500 إلكتخونيات حاسؽب
 300 أثاث كخسي

 

 الاستيلاك الذيخ
1 450 
2 470 
3 500 
4 520 
5 550 
6 600 

 

 السعجل اسػ الطالب رقػ الطالب
 85 عمي 201
 86 ليمى 204

 


